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Getting Started 

1.1 IMPORTANT! Before the first use of Symbisa 

Before attempting to use the device for the first time, please follow the 

instructions to update the device’s firmware as described in Section 2.1: Updating 

your Symbisa. It will not work otherwise. 

 

1.2 Overview 

1. Screen 

2. Button 

3. Security Seal 

4. Light Sensor 

5. Temperature/Humidity Sensor 

6. Get Started URL 

7. Firmware Version 

8. 12 Digit Serial Number 

9. Battery Level 

10. Product Warning 

11. 15 Digit IMEI Number 

12. 15 Digit IMEI Number with Barcode 

13. Regulatory Icons 

14. Safety Information 

15. Product label 

16. Micro USB Port 

Figure 1 - Symbisa Product Views 
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1.3 Registering with Symbisa 

To use the Symbisa product you first need to create an account 

on the Symbisa web site.  

Go to the URL shown on the Getting Started URL card and your 

Symbisa screen and create an account by clicking on the 

register link. Once you have completed the registration process 

you will be sent an email to confirm your details. Check your 

email address for a confirmation link and log in to your new 

Symbisa account. 

 

1.4 Devices 

• To add a Symbisa device to your account, log into the Symbisa portal and then click on the 

‘Add Device’ button which is located at the top right-hand side of the screen.  

• Key in your 12 Digit Serial Number (8) which can be found on the screen of your device and 

click next 

• Key in the requested digits from your IMEI number (11) for validation which can be found on 

the Product Label (15) on the back of the device 

• Assign an Alias to the Device (Optional) or click on the Skip for now link. An alias allows you 

to name your device within the portal. You can change the Alias later on the device page by 

clicking on the pencil icon. 

• 500 credits are added to your account for each device registered 

• Once you have added a device you can view all your devices in the Devices tab 

Figure 3 - Dashboard Devices View 

• Clicking on the Dashboard (orange) button takes you to the dashboard view, where you can 

view the device data (Section 3.1). 

• Clicking on the Settings (green) button in the devices page will bring up a page that will allow 

customisation of the device (Section 1.5). 

 

  

Figure 2- Getting Started URL Card 
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1.5 Managing your devices 

 

• Message – Allows a message of up to 24 characters to be sent to and displayed on the device 

• Bar Code – Allows a bar code of up to 15 characters to be sent to and displayed on the device 

• Interval – Allows the owner of the device to set the interval in which the device 

communicates and passes data 

• Assign Device – Allows the owner to assign and remove visibility of individual devices to 

other users so that they can view and use the data 

1.6 Adding Credit 

Credit bundles can be added to your account through the Credits tab. 

• Click on Add Credits in the Credits tab 

• Enter your Credit Bundle ID that you obtained when purchasing your credits 

• A history of your credit bundles is available to view on this page 

Figure 4 - Device Settings Page 
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2 Using your Symbisa 

2.1 Updating your Symbisa 

Before you can use your Symbisa device for the first time, an update of the firmware version is 

required. The Symbisa update installer and the firmware file can be found in the Symbisa Portal once 

you are logged in under the Resources tab. 

• Download the Symbisa Updater and the 

firmware file 

• Install the Symbisa updater to your machine 

and run the application 

• Click on the Choose Firmware (SFP file) button 

and select the firmware file that you 

downloaded from the Symbisa portal  

• Connect your Symbisa device to your PC using a 

micro USB cable, only once you see the 

Symbisa updater on the screen as shown in 

Figure 5 (Make sure that the Symbisa device is 

switched off) 

• Click on the START button and wait for the 

firmware install to complete 

For troubleshooting or support, please visit 

http://support.hanhaa.com  

2.2 First Use 

After you have registered and updated your Symbisa device successfully, you can now turn it on. To 

turn on the Symbisa device, simply press the button. You will see the screen flash for a second or 2, 

and then it will display its operational screen. On first use of Symbisa, you must wait about a minute 

for it to make the first connection. 

  

 

To turn off your Symbisa device, simply hold the button for about 5 seconds, until you see the screen 

flash and release. 

2.3 Changing Interval 

You can control the rate at which you Symbisa device sends data. This can be done on the settings 

page as shown in section 1.5 Managing your devices. The settings page can be reached from the 

devices page, by clicking on the settings button shown next to the relevant Symbisa device. 

 

1.Symbisa Splash 2.Interval Level 

3.GSM/GPRS connection 4.GPS fix available 

5.Battery charging 6.Custom Message 

7.Custom Barcode 8.Firmware Version 

9.Serial Number 10.Battery Level 

Figure 5 - Symbisa Updater 
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Figure 6 - Symbisa Screen Layout 

http://support.hanhaa.com/
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3 Viewing your Data 

There are a few ways that you can view your data: 

• Through the Dashboard, accessible via your portal 

• Via the custom functions available through the Symbisa Add in for Office 365 Excel  

• Via the custom functions available through the Symbisa Add-in for Microsoft Office Online 

• Via the use of APIs available 

3.1 Dashboard 

 Log in to your account in the Symbisa Portal 

and locate the device you want to view in 

the devices tab. Click on the Dashboard 

button to view a dashboard of the Symbisa 

devices data. In the top right of the page, 

you can set the interval in which the page 

refreshes. You can also filter your data to 

display only a specific date and time range 

To view a complete line by line sheet of your 

data, click on the Symbisa’s Serial Number 

or Alias that is displayed on the top left and then 

click on Track Details. 

 

Figure 8 - Symbisa Dashboard Track Details 

This data can be downloaded in a file and saved to your computer to be viewed locally. 

  

Figure 7 - Symbisa Dashboard 
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3.2 Microsoft Office 365 Excel  

To use the add-in with Microsoft Excel Online, please see Section 3.3.4. 

The add-in for Microsoft Excel is currently available for use on Windows with the Insiders Build 

version of Office 365 only until October 2018. If you do not have a current subscription to Microsoft 

Office 365, a free developers licence can be obtained. After October 2018, the add-in will be able to 

use from Microsoft app store, for any version of Microsoft Office 365, and the process will be much 

more simpler and user friendly. 

3.2.1 Obtaining a Developers Licence 

To obtain a year’s free developers licence for Microsoft Office 365 to use with Symbisa while it is in 

Developers Preview Mode, visit: https://developer.microsoft.com/en-us/office/dev-program. 

Stage 1: How to join the Office 365 Developer Program >> Follow all the steps on this page. 

https://docs.microsoft.com/en-us/office/developer-program/office-365-developer-program 

Stage 2: How Set up an Office 365 developer subscription >> Follow section "Set up your 

subscription" and "Configure the subscription" 

https://docs.microsoft.com/en-us/office/developer-program/office-365-developer-program-get-

started  

Please note: Once you have obtained and assigned your licence(s), follow the steps below to obtain 

the Insiders Build version of Microsoft Office. Do not install the version of Office offered in the 

Developers portal. 

3.2.2 Installing the Insiders Build version of Microsoft Office (Until October 2018) 

Currently, the add in only works with the Insiders build version of Microsoft Office 365. Depending 

on your Microsoft Office Licence, there are 2 different methods to obtain an Insiders Build version: 

• If you have a Business, Enterprise or Developers licence for Office 365 

• If you have a Commercial licence for Office 365 

3.2.2.1 If you have a Business, Enterprise or Developers licence for Office 365: 

1. Download the Office Deployment Tool from Microsoft by following the link: 

https://www.microsoft.com/en-us/download/details.aspx?id=49117  

 

2. After downloading the Deployment Tool, double click OfficeDeploymentTool.exe to extract 

the Setup.exe file and the configuration.xml file. Be sure the version of setup.exe is at least 

16.0.7407.3600. 

 

3. Use a text editor (like Notepad) and edit the configuration.xml file to make the following 

changes to the configuration section and replace it with: 

 

<Configuration> 

 

  <Add OfficeClientEdition="64" Channel="InsiderFast"> 

    <Product ID="O365BusinessRetail"> 

      <Language ID="en-us" /> 

    </Product> 

https://developer.microsoft.com/en-us/office/dev-program
https://docs.microsoft.com/en-us/office/developer-program/office-365-developer-program
https://docs.microsoft.com/en-us/office/developer-program/office-365-developer-program-get-started
https://docs.microsoft.com/en-us/office/developer-program/office-365-developer-program-get-started
https://www.microsoft.com/en-us/download/details.aspx?id=49117
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  </Add> 

 

  <!--  <Updates Enabled="TRUE" Channel="Monthly" /> --> 

 

  <!--  <Display Level="None" AcceptEULA="TRUE" />  --> 

 

  <!--  <Property Name="AUTOACTIVATE" Value="1" />  --> 

<Logging Level="Standard"  

         Path="D:\office-logs" /> 

</Configuration> 

 

This installs a 64-bit version of Office 365 Business in English from the Office Content Delivery 

Network (CDN) on the Internet. Office will also get automatically updated from the CDN when a new 

Office Insider Fast build is available. 

Please Note: If you want to install the 32-bit version, use 32 for the OfficeClientEdition setting.  

4. Copy setup.exe and configuration.xml to the computer where you want to install Office. An 

Internet connection is required to install Office. 

Please Note: If office is already installed on the computer, you need to uninstall Office and restart 

the computer before performing the next step. 

5. Run the command prompt by navigating to the start menu and typing in cmd. Right click 

cmd.exe and select ‘Run as Administrator’. Navigate to the folder where you copied the files 

by typing chdir <filePath> and run the following command: 

  

Setup.exe /configure configuration.xml 

 

This copies the Office files from the CDN on the Internet to the computer and starts the 

installation process. 

 

6. After the installation is complete, open an Office app, such as Word, and go to File > 

Account. Under the Office Updates section, you should see text that includes "Office Insider 

Fast." 

3.2.2.2 If you have a Commercial licence for Office 365: 

1. In any Office 2016 app, click File > Account > Office Insider. Select the Get early access to 

new releases of Office box, specify an update level, and then click OK. 

 

2. Visit the Additional Install Options page of My Account. Sign in with your Microsoft Account, 

if needed. In the Version menu, click the type of Insider build you want to install, and then 

click Install. If you already have Office 2016 installed on your Windows desktop, you do not 

need to uninstall it first. You’ll be updated to the Office Insider build. If you don’t see an 

Insider option on the Version menu, you may not have an active Office 365 subscription. 

 

3.2.3 Installing the Add in (Until October 2018) 

To use the Symbisa add in while it is still in preview mode, a manifest file is required. The Manifest 

file can be found and downloaded from the Symbisa Portal. 

3.2.3.1 Prepare the manifest file: 

a. Download the Symbisa-excel-add-in-manifest.xml file 
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b. Move the file to a folder on your computer  

3.2.3.2 Share a folder: 

c. Right-click the folder and choose Properties. 

d. Open the Sharing tab.  

e. Copy the Network path to use in step i. 

f. On the Choose people ... page, add yourself and anyone else 

with whom you want to share your add-in. If they are all 

members of a security group, you can add the group. You 

will need at least Read/Write permission to the folder. 

g. Choose Share > Done > Close. 

3.2.3.3 Specify the shared folder as a trusted catalogue: 

h. Open a new document in Excel. 

i. Choose the File tab, and then choose Options. 

j. Choose Trust Centre, and then choose the Trust Centre Settings button. 

k. Choose Trusted Add-in Catalogues. 

l. In the Catalogue URL box, enter the full network path to the shared folder copied in 

step e, and then choose Add Catalogue. 

m. Select the Show in Menu check box, and then choose OK. 

n. Restart the Office application so your changes will take effect. 

 

3.2.4 Using the Symbisa Add in (Microsoft Office 365 and 
Microsoft Excel Online) 

In Excel, under the Insert tab, click on the My Add-ins button. 

In the window that pops up, click on the Shared folder tab and 

select the Hanhaa Symbisa Add-in and click on the Add 

button.  

 

The Symbisa add in should now be available for to use 

whenever you open Excel. 

 

 

 

Under the Home tab, click on the Blue Symbisa Icon and a side pane will pop up. Enter your 

credentials that you made when registering on the Symbisa Portal. 

 

 

Figure 11 - Microsoft Excel Symbisa Icon 

Figure 9 - Shared Folder Properties 

Figure 10 - Office Add in Page 
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A list of your devices will pop up with Serial Number and Aliases. Clicking 

on the arrow will provide the latest sensor details of the Symbisa.  

Enter the Symbisa Serial Number or Symbisa Alias that you wish to query 

into a cell. To query a sensor, enter a custom function referencing the 

Symbisa Serial number or Alias into the cell that you wish to display the 

data. A reference sheet for the custom functions can be found in the 

Symbisa Add in sidebar by navigating to Settings>Reference Sheets and in 

the resources tab in the Symbisa Portal. 

3.2.4.1 Custom Functions 

In Excel, with the Symbisa add in running you can type into any cell to bring up the custom functions. 

All Symbisa functions are constructed as: =Symbisa.[Custom Function]([Serial Number]) and have to 

reference either a cell where the device serial number is contained, or has to contain the serial 

number within the function itself. There are 4 types of custom functions that you can call upon: 

Table 1 - Custom Functions 

=Symbisa.get_[SENSOR] Pulls up a static value, at the time of the request 

=Symbisa.stream_[SENSOR] Pulls up a value that is constantly updating 

=Symbisa.history_stream_[SENSOR] Pulls up values that are constantly updating across a 
number of cells to provide a dynamic history 

=Symbisa.send_[SENSOR] Allows the sending of data to be displayed on the device 

 

These functions are used to call on data from the sensors that are on board the device. The following 

sensors can be called by the get, stream and history_stream functions: 

• Battery 

• Date 

• Drop 

• Humidity 

• Interval 

• Latitude 

• Light 

• Longitude 

• Orientation 

• Pressure 

• Step Counter 

• Temperature 

• Time 

The send functions can send data to be stored and displayed on the device: 

• Message (up to 24 Characters) 

• Bar code (up to 15 Characters) 

• Interval (minutes) 

 

Please note: The commands are not case sensitive. 

Figure 12 - Excel Add in Overview 
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3.2.4.1.1 Custom Functions Format 

The get functions are created by selecting a cell, and then 

typing =Symbisa.get_[Sensor]([Serial Number]).  

 

 

 

The stream functions are created by selecting a cell, and 

then typing =Symbisa.stream_[Sensor]([Serial Number]). 

 

 

The history stream functions are created 

by highlighting a few cells (up to 10), and 

then typing 

=Symbisa.history_stream_[Sensor]([Serial 

Number]). You must then press the 

combination of Ctrl, Shift and Enter on 

your keyboard for the function to be 

correctly displayed. 

 

 

 

The send functions are used to send a 

message and/or a barcode to the device to 

display on the screen. They reference the 

serial number, and a message – both of which 

can either be typed out into separate cells, or 

directly into the function itself. They are 

created by selecting a cell, and then typing 

=Symbisa.send_[Function]([Serial 

Number],[Data]).  

As with the Serial Number and the Alias, you have the option of entering the message and barcode, 

either into a cell and reference the cell as shown above, or you can enter it directly into the formula. 

So =SYMBISA.SEND_MESSAGE(A1,B1) is the same as 

=SYMBISA.SEND_MESSAGE(45CD9162RD27,”Hello World!”) 

 

3.2.4.1.2 Template 

To help you get started, you can use the template found in the Resources section of the Symbisa 

Portal. The template is populated with a table and data visualisations for some of the sensors.  

  

Figure 13 - Get Function 

Figure 14 - Stream Function 

Figure 15 - History Stream Function 

Figure 16 - Send Data Function 
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3.3 APIs 

To use the APIs, login to the Symbisa portal and you will see API KEYS and API in the left-hand pane. 

 

 

 

 

 

 

 

 

 

3.3.1 API Keys 

To generate an API key, navigate to the API KEYS 

page, and click on the Generate API Key link. A 

window will pop up where you can name the API 

and select the duration.  

 

 

 

 

A list of API keys that have been generated will display on this page. The Keys are valid for the period 

that was set when they were generated. On the right-hand side of the page, you will see your API 

Signature Client ID and Client Secret. You can copy all these quickly by pressing the icon on the right. 

 

 

Figure 17 - API Location 

Figure 18 - Generate API Key 

Figure 19 - API Key page 
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3.3.2 API 

The API page provides access to the different API requests that can be made. Clicking on the 

dropdown found on the right-hand side on the API page, allows you to select between the 3 

different types of APIs available: 

• User Account and Authentication 

• Device Messaging 

• Portal  

You can cycle through the List of APIs and request information against your devices. Each item in 

the list provides Response Class, Parameter input and Response codes. 

 

  

 

 

 

  

Figure 20 - API Dropdown 

Figure 21 - API List Items 
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3.3.3 Web API String Data Parameters  

3.3.3.1  Environmental Sensors 

PARAMETER  DESCRIPTION  Beta Version  

Average  

Temperature  

Average temperature value within the reporting interval 
in degree Celsius, formatted with 1 decimal value.  

i.e. 19.5°C (Sampling frequency 1 acquisition per min)  

YES  

Maximum  

Temperature  

Maximum temperature value within the reporting 

interval in degree Celsius, formatted with 1 decimal 

value. i.e. 25.5°C  

YES  

Minimum  

Temperature  

Minimum temperature value within the reporting 

interval in degree Celsius, formatted with 1 decimal 

value. i.e. 16.5°C  

YES  

Average Humidity  Average humidity value within the reporting interval in 
RH percentage, formatted with 1 decimal value.  

i.e. 45.6 %RH (Sampling frequency 1 acquisition per min)  

YES  

Maximum Humidity  Maximum humidity value within the reporting 

interval in RH percentage, formatted with 1 decimal 

value. i.e. 76.6 %RH  

YES  

Minimum Humidity  Minimum humidity value within the reporting 

interval in RH percentage, formatted with 1 decimal 

value. i.e. 32.6 %RH  

YES  

Average Pressure  Average pressure value within the reporting interval 
expressed in hPa, formatted as integer.  

i.e. 997 hPa (Sampling frequency 1 acquisition per min)  

YES  

Maximum Pressure  Maximum pressure value within the reporting 

interval expressed in hPa, formatted as integer. i.e. 

997 hPa  

YES  

Minimum Pressure  Minimum pressure value within the reporting 

interval expressed in hPa, formatted as integer. i.e. 

997 hPa  

YES  

Average Light  Average light value within the reporting interval 
expressed in Lux, formatted as integer.  

i.e. 1400 lux (Sampling frequency 1 acquisition per min)  

YES  

Maximum Light  Maximum light value within the reporting interval 
expressed in Lux, formatted as integer.  

i.e. 1400 lux  

YES  

Min Light  Min Light value within the reporting interval expressed in 
Lux, formatted as integer.  

i.e. 1400 lux  

YES  
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Table 2  

3.3.3.2 Accelerometer & Gyroscope  

 PARAMETER  DESCRIPTION  Beta Version  

Tilt  Interrupt functionality - Notify an angular variation of 
more than 35° in any direction.   

(this parameter could be the cumulative number of tilts)  

YES  

(Accumulation)  

Free fall  Interrupt functionality - Notify a freefall event of 50cm.   YES  

(Accumulation)  

Orientation  Interrupt functionality - Notify the side of the device 

facing up.   

YES  

(Report latest)  

Step Counter  Number of steps accumulated since the start of the 

application. Integer number.  

YES  

 Table 3 

3.3.3.3 GSM / GPRS  

 PARAMETER  DESCRIPTION  Beta Version  

Cell Info  Notify the Engineering parameter of the (CellID, MNC, 

MCC, LAC)  

YES  

Signal Quality  Notify the GSM signal quality (RSSI) according to Quectel 
scale.  

YES  

 Table 4  

3.3.3.4 GPS  

 PARAMETER  DESCRIPTION  Beta Version  

Latitude & Longitude  NMEA format for GPS coordinates  YES  

Altitude  - GGA  YES  

Horizontal Dilution of  

Precision  

- GGA  YES  

 Table 5  

3.3.3.5 Others  

 PARAMETER  DESCRIPTION  Beta Version  

USB  

plugged/unplugged  

Interrupt functionality -  

Notify the status of the USB port  

YES  
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Charging / Not Charging  Notify the status of the charging  YES  

SOC (State of Charge)  Notify the battery percentage  YES  

Button press  Interrupt functionality - Notify if the button has been 
pressed  

YES  

(Accumulation)  

Date & Time  Notify the RTC date and time based on GSM or GPS time  YES  

(If available)  

Firmware Version  Firmware version (Mandatory*)  YES 

Serial Number  Serial Number of the Device (Mandatory*)  YES  

Interval  Interval expressed in minutes  YES  

Message Counter Incremental count of messages generated by device since 

last activated. 

YES 

 Table 6 

3.3.3.6 On Screen Display Functions  

PARAMETER  DESCRIPTION  Beta Version  

Message  Send a message to be displayed on the device 

screen,  alpha-numeric message (max 26 characters) 

YES  

Barcode Send a Barcode to be displayed on the device screen, 

Barcode format - Code39 (max 15 characters)  

YES  

Table 7 
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4 Specifications 

4.1 General 

Para Parameter Specification 

1 Battery life 15 days cycle time based upon an hourly status 

reporting interval. 

2 Location accuracy Standard GNSS resolution, 3 to 300 meters (accuracy 

provided with PDOP Position Dilution of Precision 

parameter) 

4 Shock detection Up to ±16g 

5 Ambient light detection wavelength 560nm 

6 Ambient light detection light threshold 0.01 lux to 83k lux 

7 Pressure sensing range 260 to 1260 hPa <absolute pressure range, need to 

validate against operating range> 

8 Pressure sensing resolution  ±1 hPascals RMS 

9 Humidity sensing range 5 to 90% non-condensing  

10 Humidity sensing accuracy ±3.5% rH, 20 to +80% rH, ±5% rH 0 to 100%  

11 Temperature sensing accuracy ±1°C 10 to +50 C  

12 Temperature sensing resolution ± 0.5 °C 

13 Display 2.9” low power consumption E-paper display  

Table 8 

4.2 Electrical Specification 

4.2.1 GSM Radio Performance 

Para Parameter Specification 

1 Band Support Quad Band, R99 BANDS: 

    GSM 850, GSM 900, GSM 1800, GSM 1900 

2 GPRS Class Multi-slot class 12/10/8 

3 Radio Standards Compliance See Regulatory section for radio standards compliance. 

Table 9 

4.3 Device Physical Specification 

4.3.1 Physical Design – General 

Para Parameter Specification 

1 Weight – unpackaged 
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2 Weight – packaged 160g 

3 Product dimensions 130 mm (W) x 100 (H) x 10.5 mm (D)  

4 Flammability Case meets UL94-HB75 

Table 10 

4.3.2 Package Contents 

As standard the Symbisa comes with a quick start card in the box. The card will contain a URL that 

directs to symbisa.com/get-started. 

The following accessories are recommended to be used with Symbisa. 

4.3.2.1 AC Power Adaptor 

If an AC power adaptor is to be used to power or charge the Symbisa device, then it is recommended 

that the power adapter complying with the specification shown in Error! Reference source not f

ound. is used. 

Para Parameter Specification 

1 Recommended power adapter manufacturer PowerPax 

2 Recommended power adapter model (UK) SW4479B 

3 Power supply input voltage AC 90 to 264VAC at ~50/60Hz 

4 Power supply output voltage DC 5V @ 2.1A 

5 AC plug type To suit country of operation 

6 DC plug type USB micro B plug 

Table 11 

4.3.2.2 Connecting Cable 

A USB cable with a standard A plug and micro B plug is required for connecting between the host PC 

or AC power adapter and the Symbisa device. 

4.4 Environmental Specification 

4.4.1 Operational 

Para Parameter Specification 

1 Temperature - operating - 15 to +50 C (limited by the operating temperature 

range of the lithium battery) 

2 Humidity 5 to 90% non-condensing 

3 Rate of change of temperature Max 0.5 °C/min averaged over a period of 5 mins 

4 Air Pressure 70 to 106 kPa 

Table 12 
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4.4.2 Storage Transportation and Handling 

Para Parameter Specification 

1 Temperature - storage -20 to + 60 C (Storage at the extremes of this 

temperature range should not exceed more than 1 

month) 

2 Humidity 5 to 95% non-condensing 

3 Rate of change of temperature Max 0.5 °C/min averaged over a period of 5 mins 

4 Air pressure 70 to 106 kPa 

Table 13 

 

4.5 Cellular Country Support 

The Symbisa product has cellular support in the countries shown in Table 14. 

 Country ISO 3  Mobile Country Code 

1 USA USA 310, 311, 312, 313, 314, 316 

2 Canada CAN 302 

3 Austria AUT 232 

4 Belgium BEL 206 

5 Denmark DNK 238 

6 Finland FIN 244 

7 France FRA 208 

8 Germany DEU 262 

9 Greece GRC 202 

10 Ireland IRL 272 

11 Italy ITA 222 

12 Luxembourg LUX 270 

13 Netherlands NLD 204 

14 Portugal PRT 268 

15 Spain ESP 214 

16 Sweden SWE 240 

17 UK GBR 234 

18 Bulgaria BGR 284 
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19 Cyprus CYP 280 

20 Czech Republic CZE 230 

21 Estonia EST 248 

22 Hungary HUN 216 

23 Latvia LVA 247 

24 Lithuania LTU 246 

25 Malta MLT 278 

26 Poland POL 260 

27 Romania ROU 226 

28 Slovenia SVN 293 

29 Slovakia SVK 231 

30 Gibraltar GIB 266 

31 Guadeloupe GLP 340 

32 Martinique MTQ 340 

33 Reunion REU 647 

34 French Guiana GUF 340 

35 Iceland ISL 274 

36 Liechtenstein LIE 295 

37 Norway NOR 242 

38 Croatia HRV 219 

Table 14 
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5 Support and Important Information 

5.1 Support 

Please use the Support webpages on the Hanhaa website to browse the Knowledge Base or if 

required to raise a support ticket. 

https://support.hanhaa.com 

5.2 Warranty 

Please note, that the Symbisa warranty will be voided if: 1) There are any attempts to open the 

Symbisa device. 2) The security seal has been tampered with - Each device comes with a security seal 

on the top right-hand corner of the device. If the seal is missing, or shows void, your warranty will be 

voided. 

5.3 Instruction for Safe Use 

To avoid exposing the user to potential health risk or device malfunction, please follow the 

guidelines below. 

5.3.1 Safe usage and Warnings! 

Lithium polymer battery: 

• Warning: Never use a damaged device, such as one with a cracked display or badly damaged 

rear cover, as it may cause injury or harm. In the event of damage to the Symbisa device it 

should be evaluated if repair is necessary by a Hanhaa approved service partner before 

further use is attempted. 

• Warning: Never expose the device to flames. 

• Warning: Never dispose of the device in a fire, as it may explode. 

• Handle with care and keep in a clean and dust-free place. 

• For best performance: 

o The device should not be operated in temperatures either below minus 10°C (+14°F) 

or above +45°C (+113°F).  

o Always ensure the device is charged whilst the temperature is between +5°C (+41°F) 

and +45°C (+113°F). 

• Warning: Never expose the device or battery to temperatures above +60°C (+140°F). 

• Do not try to crush, distort, bend, drop or throw the device. 

• There are no user serviceable parts inside, do not attempt to disassemble or modify the 

product. 

• Any servicing should be carried out by a Hanhaa’s approved supplier or service agent. 

Mobile radio transceiver: 

• Warning: Never attempt to use the device near pacemakers or other medical equipment 

without consulting with the instructions of the medical device and gaining approval of the 

relevant medical staff. 

• Warning: Never the use the device in potentially explosive atmospheres. 

• Warning: As a result of the containing a radio transmitter, this device may affect implanted 

medical equipment, such as pacemakers. 

• Warning: Specific Absorption Rate (SAR) is used to measure radio frequency energy 

absorbed by the body when using a cellular device. To comply with the SAR regulations, do 
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not operate the device within 10mm from the human body. Do not cover the antenna with 

your hand as this affects call quality, power levels and can shorten the battery life. The SAR 

value is determined at the highest certified power level in laboratory conditions, but 

because the device is designed to use the minimum power necessary to access the chosen 

network, the actual SAR level can be well below this value.  

Location functions: 

• The Symbisa device contains location based functions and any such location resolving 

functionality is provided “As is” and “With all faults”. Hanhaa cannot not make any 

representation or warranty as to the accuracy of such location information since it is 

dependent upon services outside of its control. 

• The Symbisa device may not be able to provide uninterrupted or error free location 

information and may additionally be dependent on network service availability. Such 

location based functions may be impaired or inhibited in certain environments such as 

within or between buildings. 

General Symbisa usage: 

• Warning: The device is not a toy, keep out of children’s’ reach.  

• Warning: Never use outdoors or in damp areas. 

• Warning: The devices’ battery should only be removed and replaced by a Hanhaa approved 

service agent. Any replacement battery shall be of the same type and qualified by Hanhaa. 

The use of a battery not approved by Hanhaa may present a risk of fire, explosion, leakage or 

other hazard. 

• The device’s performance depends on ambient temperatures, cellular coverage and 

reporting intervals. 

If in doubt as to the device’s proper function, have the device checked by an approved Hanhaa 

service agent before charging or using it. 

5.4 RE Directive “Informal DoC” statement 

Hanhaa Limited declares that this product is in compliance with the essential requirements and 

other relevant provisions of Directive 2014/53/EU. 

For details, please access the following URL: 

http://www.hanhaa.com/compliance 

This radio equipment is intended to be used with the approved version(s) of software that are 

indicated in the EU Declaration of 

Conformity.  

 

Wireless frequency bands and maximum output power: 

Frequencies: GSM GPRS/EDGE 850, 900, 1800 & 1900. 

Output Power: Class 4 (2W @850/900MHz) & Class 1 (1W @1800/1900MHz) 

Note: some frequency bands may not be enabled in some markets or operators. 

5.5 WEEE Statement  

This section is applicable in the European Union and other European countries with separate 

collection systems. 

http://www.hanhaa.com/compliance
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The Wheelie Bin Symbol (see above) on the device or on its packaging indicates that this device shall 

not be treated as household waste. Instead it shall be handed over to the appropriate collection 

point for the recycling of electrical and electronic equipment. 

By ensuring this device is disposed of correctly, you will help prevent potential negative 

consequences for the environment and human health, which could otherwise be caused by 

inappropriate waste handling of this device. 

5.6 FCC Statement for USA customers 

This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the equipment off 

and on, the user is encouraged to try to correct the interference by one or more of the following 

measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 


